Export TimeCode for gma3

“(OF) COURSE

This is simple tool to Export Cue List (Sequence) with Timecode to the grandMA3, with many tracks.
Change Cue Number (renumber), Cue Fade from within the application. You can also print your Cue List (Sequence).

Now you can export cue list and timecode from midi file. Midi file you can prepare in almost all music application like Pro Tools, Logic Pro, Cubase, Reaper etc.

In this help we show you how export cue list and timecode from Reaper.
Just import to Reaper multimedia file (music or video) you’re working on.

Prepare all Cues (Markers in Reaper) — light changes, accents, solos, etc. that you want to use in show.

Export TimeCode for gma3 will finish all work for you by importing to console Of Course:
— Timecode number

—Timecode name

—FPS

— Page number

—Page name

— More than one Cue List (Sequence)
— More than one Track in Timecode
—Sequence number

—Sequence name

— Executor number

— Cue Fade

As simple as that!
Don’t miss that chance! Do not hesitate and try it completely for free!

Description:

Download and install "Reaper":
http://www.reaper.fm/download.php

Download and install "SWS Extension" for Reaper:
http://www.sws-extension.org/

Run Reaper.
1. Open File tab and Project settings.

& REAPER File Edit View Insert Item Track Options Actions Extensions Window

New project

New project tab

Open project...

Save project

Save project as...

Save new version of project
Save all projects

Project templates
Recent projects

Close project
Close all projects

Project settings...

Render...

Open render queue

Region Render Matrix

Batch file/item converter {0 8F
Save live output to disk (bounce)... 3B

Consolidate/Export tracks...
Export project MIDI...

Clean current project directory...

Help

[44.1kHz 24bit WAV : 0/2ch 512spls ~11/20ms]
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Filter:

ID Description
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Clear



2. Set Frame rate (FPS) the one you want to use in the show.
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Project Settings

Project Settings
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Frame rate: 30
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Video colorspa
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n resizing

10x) when resizing

Cancel

3. Open View tab and set Time unit for ruler to Hours:Minutes:Seconds:Frames.

& REAPER File Edit View Insert Item Track Options Actions Extensions

#M

Window Help
Mixer

Master Track X #M

Floating Mixer Master
X 8T
8V

v Transport
v Video

Monitoring FX

Docker
Toolbar Docker

Media Explorer
Routing Matrix
Grouping Matrix
Track Wiring
Project Media/FX Bay
Track Manager
Screensets/Layouts

v Region/Marker Manager
FX Browser
Media Item Properties

#B
0EM
$®E

OF
F2

v Big Clock
Performance Meter
Peaks Display Settings

XC
X3P

X8V
XT

Navigator

Tempo Envelope
Scale Finder

Virtual MIDI Keyboard B
Show/hide all floating windows X 38F
Cascade all floating windows

Minutes:Seconds
Measures.Beats
Measures.Beats (minimal)
Seconds
Samples

v Hours:Minutes:Seconds:Frames
Absolute Frames
Secondary time unit [ 2

Time unit for ruler

Zoom
Go to

Always on top

Fullscreen B

Media QRICECE Advanced

Notes

lower numbered tracks replace higher

Save as default project settings

[44.1kHz 24bit WAV : 0/2ch 512spls ~11/20ms]
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Filter:
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4. Open Insert tab and insert Track.

& REAPER File Edit View

Extensions

Insert Item Track Options Actions

Media file...
New MIDI item
Empty item

SMPTE LTC/MTC Timecode Generator
Click source

New subproject

Marker
Marker (prompt for name)

Tempo/time signature change marker

Track

Multiple tracks...

Virtual instrument on new track...
Track from template

5. Open Insert tab and Import your media file.

& REAPER File Edit View

Route

Extensions

@

Insert Item Track Options Actions

Media file...
New MIDI item
Empty item

SMPTE LTC/MTC Timecode Generator
Click source

New subproject

Marker
Marker (prompt for name)

Tempo/time signature change marker

Track

Multiple tracks...

Virtual instrument on new track...
Track from template

Window Help

Window Help
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Render Matrix...
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Filter:
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ID Description
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End Length

Filter:




6. Create a Cue List (Sequence) use the Markers and give the names for Cues. Important: don’t use comma (“,”) in cue name.
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ID Description

:00:00 1 pre show
4:05 2 start

Add Marker

Name: | hit|

Position:  0:00:06:07

Set color... Reset color

Regions
v Markers
#~ Name Start End Length
M1 pre show 0:00:00:00
M2 start 0:00:04:05

Filter:

7. Save Reaper Project.

8. Open View tab and open Region/Marker Manager.
9. Click right mouse button and use the tab Export region/markers, name the text file (*.csv) and save it.

Description

pre show

start

hit

hit

hit

hit

verse
0:00:22:28 chorus
0:01 3 frase
0:00:31:09 solo

Route

[ JoX J Region/Marker Manager

Regions
Markers
#~ Name Start End Length
[C] M1 pre show 0:00:00:00
= Al
Delete selected markers/regions
Renumber in timeline order (markers, then regions)

Import regions/markers (replace existing)
Import regions/markers (merge with existing)...
Export regions/markers...

0:00:

0:00:22:28
0:00:27:03
0:00:31:09

v Seek playback when selecting a marker or region
Play region through then repeat or stop when selecting a region

Dock Region Manager in Docker

Close window




Your Cue List (Sequence) with Timecode is ready a can export it to the grandMA3 use Export TimeCode for gma3.
Run Export TimeCode for gmas3.

Timecode number

1

Timecode label
TimeCode

FPS

30

Add time

00 00 00 00

change time

Page number

1

Exec number
201

Sequence number
2

Sequence label
Cuelist 1

Page label
Page

Add new track

Delete track

Settings
Help

Our Apps
You are logged with Apple account

1. Click tab Settings.

2. Set directories for Timecode and Macro — grandMA3 onPC Folders or USB Memory Stick Folders.
3. Set directories for Projects file, default is yours document folder.

4. You can also set default Fade for Cues.

5. Save settings.

Settings
Document folder (for repaer or music projects file)

[Users/makus/D [E; tTimeCode/Proj /

Export folder (default [Disk]/grandMA3)

[Users/makus/MALightingTechnology/gma3_1.1.4

Default fade time 2.00

Purchase of subscription is possible only after logging into the account in the application. In addition to purchases, the account
gives the ability to synchronize settings, access information on new products, faster and more reliable contact with support. We
never send you emall and Export TimeCode Is 100% ad free.

You are logged with Apple account. (click to logout)
Version: Full version for one month
show tutorial on StartUp

Reset to default




6. Click tab ‘Add new track’ and select your Cue List (Sequence).

Directly from Reaper Project.

Recents
Applications
Downloads
ownCloud
Movies
Music
Pictures
makus
iOSProjects
TC&TT_2020
gma3_1.1.4
OneDrive -...

OneDrive

< iCloud Drive

You are logged with Apple account

from exported text file from Reaper Project (*.csv).

Recents
Applications
Downloads
ownCloud
Movies
Music
Pictures
makus
iOSProjects
TC&TT_2020
gma3_1.1.4
OneDrive -...

OneDrive

< iCloud Drive

You are logged with Apple account

25fps145bmp_1hs
tart.mid

O

OfCourse_Export
TC.RPP

New Folder

25fps145bmp_1hs
tart.mid

O

OfCourse_Export
TC.RPP

New Folder

Export TimeCode for gma3

Track 1

Fade

m Projects

30fps145bmp_1hs
tart.mid

OfCourse_Export
TC_markers.csv

song_1cue_not0.
mid

Export TimeCode for gma3

Track 1

Fade

m Projects

30fps145bmp_1hs
tart.mid

OfCourse_Export
TC_markers.csv

song_1cue_not0.
mid

O

OfCourse_Export
TC_Video.RPP

OfCourse_Export
TC_Vide...kers.csv

song.mid

Cancel

0

OfCourse_Export
TC_Vide...kers.csv

OfCourse_Export
TC_Video.RPP

song.mid

Cancel

Timecode number

1

Timecode label
TimeCode

FPS

30

Add time

00 00 00 O00

change time

Page number
1

Exec number
201

Sequence number
2

Sequence label
CuelList 1

Page label
Page

Add new track

Delete track

Settings
Help

Our Apps

Timecode number

1

Timecode label
TimeCode

FPS

30

Add time

00 00 00 00

change time

Page number
1

Exec number
201

Sequence number
2

Sequence label
Cuelist 1

Page label
Page

Add new track

Delete track

Settings
Help

Our Apps




Or, from midi

Recents
Applications
Downloads
ownCloud
Movies
Music
Pictures
makus
iOSProjects
TC&TT_2020
gma3_1.1.4
OneDrive -...

OneDrive

< iCloud Drive

You are logged with Apple account

As a result, you will see your Cue List (Sequence).

Name

pre show
start
hit1

hit 2

hit 3

hit 4
verse
chorus
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frase
solo

1=}

You are logged with Apple account

Export TimeCode for gma3
Track 1

Fade

™ Projects

O

25fps145bmp_1hs 30fps145bmp_1hs OfCourse_Export OfCourse_Export OfCourse_Export
tart.mid tart.mid TC_markers.csv TC_Vide...kers.csv TC_Video.RPP

O

OfCourse_Export song_1cue_not0. song.mid
TC.RPP mid

New Folder

Export TimeCode for gma3
Track 1

Time Fade
00:00:00:00 2.09
00:00:04:05 2.09
00:00:06:06 2.09
00:00:08:10 2.09
00:00:10:13 2.09
00:00:12:16 2.09
00:00:14:18 2.09
00:00:22:29 2.09
00:00:27:06 2.09
00:00:31:09 2.09

Timecode number

1

Timecode label
TimeCode

FPS

30

Add time

00 00 00 00

change time

Page number
1

Exec number
201

Sequence number
2

Sequence label
CuelList 1

Page label
Page

Add new track

Delete track

Settings
Help

Our Apps

Timecode number
1

Timecode label
TimeCode

FPS
30

Add time
00 00 00 00

change time

Page number
1

Exec number
201

Sequence number
2

Sequence label
Cuelist 1

Page label
Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps




Now you can change the Name, Number, Fade for cues.

Export TimeCode for gma3

Track 1 )
Timecode number

Name Time Fade 1
pre show 00:00:00:00 2.09 Timecode label
start 00:00:04:05 2.09 TimeCode

o
&
&

hit 1 00:00:06:06  2.09 PS
hit 2 00:00:08:10 2.09 30
hit 3 13 209 Add time

change fade time
hit 4 1 116 2.09 00 00 00 00

change cue name

verse remove cue 18 209 change time
ELED  ——] 209 =
frase 00:00:27:06 2.09 Page number
solo 00:00:31:09 209 1
Exec number

201
Sequence number

2
Sequence label

CuelList 1

© © N|o o s |

3

Page label
Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps
You are logged with Apple account

o not forget to set Timecode number, Timecode label, Page number, Executor number, Sequence number, Sequence label, Page label.

Timecode number

Name Time 1

o
€
&

pre show 00:00:00:00 Timecode label
start 00:00:04:05 TimeCode

hit 1 00:00:06:06 FPS

hit 2 00:00:08:10 30

hit 3 00:00:10:13 Add time

hit 4 00:00:12:16 00 00 00 00
verse 00:00:14:18 change time
chorus 00:00:22:29 -
frase 00:00:27:06 Rassnumbey

solo 00:00:31:09 1

Exec number

201

Sequence number

2

Sequence label
Light

Page label
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Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps
You are logged with Apple account




can now import another track (Sequence) into the same Timecode.

Export TimeCode for gma3

Track1 | Track 2 )
Timecode number

Fade 1
Timecode label
TimeCode

FPS
M Projects

Recents ’ 30

Applications Add time
Downloads 00 00 00 00

change time
ownCloud

Movies Page number
25fps145bmp_1hs 30fps145bmp_1hs OfCourse_Export OfCourse_Export OfCourse_Export
Music tart.mid tart.mid TC_markers.csv TC_Vide...kers.csv TC_Video.RPP 1

Exec number
202
makus
f? Sequence number
iOSProjects 3
TC&TT_2020 OfCourse_Export song_1cue_not0. song.mid Sequence label

gma3_11.4 TC.RPR mid CueList 3

Pictures

OneDrive -... Page label

Page
OneDrive

New Folder Cancel

Add new track
Delete track

Generate files

Renumber
Print Cue list
Settings
Help

Our Apps
You are logged with Apple account

As a result, you will see Cue Lists (Sequences) — Tracks in Timecode.
Now you can change the Name, Number, Fade for cues.

9. Do not forget to set, Executor number, Sequence number, Sequence label.

Export TimeCode for gma3

Track1 | Track2
Timecode number

Name Time Fade 1

pre show 00:00:00:00 2.09 Timecode label
movie 1 00:00:04:05 2.09 TimeCode

movie 2 00:00:11:14 2.09 FPS

movie 3 00:00:18:23 2.09 30

movie 4 00:00:26:03 2.09 Add time

end 00:00:31:09 2.09 00 00 00 O00

change time

Page number
1

Exec number
202

Sequence number
3

Sequence label
Video

Page label
Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps
You are logged with Apple account




You can also print Cue Lists (Sequences).

o
c
&

Name

pre show
start
hit1

hit 2

hit 3

hit 4
verse

chorus
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frase

solo

=}

You are logged with Apple account

Name

pre show
movie 1
movie 2
movie 3
movie 4

end

You are logged with Apple account

Export TimeCode for gma3
Track1 Track 2

Time Fade
00:00:00:00 2.09
00:00:04:05 2.09

Print

Printer: | PrinterBiuro
Presets: ~ Default Settings
Copies: 1 s
Black & White

Pages: ® All

From:

Show Details

Export TimeCode for gma3
Track1 | Track 2

Time Fade
00:00:00:00 2.09
00:00:04:05 2.09

Print

Printer: | PrinterBiuro
Presets: Default Settings
Copies: 1 2
Black & White

Pages: ® All

From: 1

Show Details

Timecode number

1

Timecode label
TimeCode

FPS

30

Add time

00 00 00 00

change time

Page number
1

Exec number
201

Sequence number
2

Sequence label
Light

Page label
Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps

Timecode number

1

Timecode label
TimeCode

FPS

30

Add time

00 00 00 00

change time

Page number
1

Exec number
202

Sequence number
3

Sequence label
Video

Page label
Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps




Finally, you can export Cue List (Sequence) with Timecode to g

1. Click tab Settings.

2. Set directories for Timecode and Macro — grandMA3 onPC Folders or USB Memory Stick Folders.

Settings
Document folder (for repaer or music projects file)

[Users/makus/D [E: tTimeCode/Proj /

Export folder (default [Disk]/grandMA3)
[Volumes/MAKUS 1/grandMA3
Default fade time 2.00

Purchase of subscription is possible only after logging into the account in the application. In addition to purchases, the account
gives the ability to synchronize settings, access information on new products, faster and more reliable contact with support. We
never send you emall and Export TimeCode Is 100% ad free.

You are logged with Apple account. (click to logout)
Version: Full version for one month
show tutorial on StartUp

Reset to default

3. Click tab Generate files, you can choose that you have marge cue or not. If you export to USB disk please select checkbox.

Name

pre show
movie 1
movie 2
movie 3
movie 4
end

Export TimeCode for gma3
Track1 | Track 2

Time Fade
00:00:00:00 2.09
00:00:04:05 2.09
00:00:11:14 2.09
00:00:18:23 2.09

00:00:00:nn ana

00:

.

Export TimeCode for gma3

Do you want to merge cue in all sequence?
(marge don't import fade values)

+ Do you want export to USB disk?

You are logged with Apple account

Timecode number

1

Timecode label
TimeCode

FPS

30

Add time

00 00 00 O00

change time

Page number
1

Exec number
202

Sequence number
3

Sequence label
Video

Page label

Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps




Confirm your folder choose.

Export TimeCode for gma3

Track1 | Track2 )
Timecode number

Name Time Fade 1

pre show 00:00:00:00 2.09 Timecode label
movie 1 00:00:04:05 2.09 TimeCode
movie 2 00:00:11:14 2.09 EPS

movie 3 00:00:18:23 2.09 30

movie 4 An.nn.ne.nn 2na

d
en i grandMA3
Recents

Applications
Downloads

ownCloud -

Movies config export
Music

Pictures

makus

iOSProjects

TC&TT_2020

gma3_1.1.4

OneDrive -...

OneDrive ¥ Do you want open folder after generate timecode?
New Folder Options Cancel Open
& iCloud Drive
Renumber
Print Cue list
Settings
Help

Our Apps
You are logged with Apple account

Your Cue Lists (Sequences) with Timecode selected Page, Executor, Fade is ready to be imported using a Macro from folder in grandMA3 onPC or from macro on USB Memory Stick!

Export TimeCode for gma3

Track1 | Track 2 )
Timecode number

Name Time Fade 1

pre show 00:00:00:00 2.09 Timecode label
movie 1 00:00:04:05 2.09 TimeCode

movie 2 00:00:11:14 2.09 FPS

movie 3 00:00:18:23 2.09 30

movie 4 00:00:26:03 2.09 Add time

end 00:00:31:09 2.09 00 00 00 O00

change time

Page number

"l 1
Exec number

202
Export TimeCode for gma3 Sequence number

Create new Macro, choose import, select 3
correct drive and choose file M.xml to
import, after this run imported Macro. Sequence label

Video

OK Page label

Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps
You are logged with Apple account




4. Run your show on grandMA3.

ecode] Display 1

Page ) . -
Playback <Page1Pe  Wingl Timecode 10) o, &) e

Timecode " Mode 1

SR <No timecode> Setup

lode
Timeline

Fixture

Preset

3

Sequence
Sheet

4

Tracking
Sheet

Phaser

Help
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G Delet
I’i Macros ° elete

<4 E=  Admin[Fixture]> L]

sheuts

= ST
Sync MAtricks M;as?er

=) 5 100.0%

Single D
Step > .
Aign Cursor Screen Y
< 0.00 Display 1

Readout Track TimeRange Marker Screen X
Percent 0.00 <No Markers> Display 1

5. Create new macro, click Import

o )

# Lock No Name Command Wait Enabled AddToCmdl Execute

New MacroLine

i GO
Insert New MacroLine Macro 3

Appearance 7" scribble L
LEEIEHES
E&  Admin@ShowData/DataPools/Default/Macros/Macro 3> )

shcuts

- —
sync MAtricks Master

o 100.0%
Single [
Step Edit > ®

Cursor Screen Y
0.00 Display 1

Readout Track TimeRange Marker Screen X
Percent I 0.00 <No Markers> Display 1

Align

<




6. Choose correct disk (USB or local), and choose M.xml file.

onPC1 [timecode] Display 1

A N R
[aa)

Filter:

Lock No Name FileName FileSize  FileTime Path

SL 1 CueList.xml CueList.xml 163B  15.06.2020 //Volumes/MAKUS
M.xml M.xml 2.3kB  30.06.2020 /Volumes/MAKUS

7. Now run this Mac

* Lock No Name Command Wait Enabled AddToCmdl Execute

1 MacroLine 1 Store Sequence 2 Cue 1"pre show" /m

0O MacroLine 2 Store Sequence 2 Cue 2 "start” /m
MacroLine 3 Store Sequence 2 Cue 3 "hit 1" /m
MacroLine 4 Store Sequence 2 Cue 4 "hit 2" /m
MacroLine 5 Store Sequence 2 Cue 5 "hit 3" /m
MacroLine 6 Store Sequence 2 Cue 6 "hit 4" /m
MacroLine 7 Store Sequence 2 Cue 7 "verse" /m

MacroLine 8 Store Sequence 2 Cue 8 "chorus” /m

© ® N o g AW N

MacroLine 9 Store Sequence 2 Cue 9 "frase” /m

3

MacroLine 10 Store Sequence 2 Cue 10 "solo” /m

MacroLine 11 Store Page 1

)

MacroLine 12 Label Page 1"Page"

@

MacroLine 13 Assign Sequence 2 At Page 1.201

=

MacroLine 14 Label Sequence 2 "Light"

o

MacroLine 15 Store Sequence 3 Cue 1 "pre show" /m
16 MacroLine 16 Store Sequence 3 Cue 2 "movie 1" /m
17 MacroLine 17 Store Sequence 3 Cue 3 "movie 2" /m
18 MacroLine 18 Store Sequence 3 Cue 4 "movie 3" /m

19 MacroLine 19 Store Sequence 3 Cue 5 "movie 4" /m

Insert New MacroLine Cut GO

Macro 3 'Export TimeCode (OF COURSE)'

Scribble List
a Delete Copy Oops References

4 E=  Admin@ShowData/DataPools/Default/Macros/Export TimeCode (OF COURSE)> = 2

sheuts

T oo
Sync MAtricks M;as?er

nale |55 100.0%
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Align : ' Cursor ‘ ScreenY

0.00 Display 1

Readout ‘ Track . . TimeRange Marker Screen X

Percent 0.00 <No Markers> Display 1
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Page gID o View Mode . Timecod Mode 1
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20 2202 F
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100 0>5T 1000 Sheet

Master ~ Master 4

100.0%  100.0% Tracking
Sheet

Phaser

Help
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2 1

3
_Export

a TimeCode Go Delete | TimeCode

a Macros COURSE)

<4 EE  Admin[Fixture]> L]

sheuts

Grand
Sync MAtricks M;as?er

: " = 100.0%
Single i)
Step > .
ANign Cursor Screen Y
< 0.00 Display 1

Readout Track TimeRange . Marker Screen X

Percent 0.00 <No Markers> Display 1

- = o o
A Time] Text Mode View Mode Mode
©) imecodej2}limeCode#:Select! 0s [0) Q @ S) All Both Settings E_] Setup

0.00s
% 99 Lock No » Name Play Rec | 0.00s 15.00s 30.00s 45.00s Lock Track Name Time Token
\\Hl\IHHHI‘HHHH\‘HHHH\‘IHHHH \HHHH‘HHIHH‘\HHHH HHHHI‘IHHHHIHHHHI

Cue
Destination
A
1(2) > ITrackGroupW I - : L ’,’ L S L ’> : 1'Light' 0.001s Cue 1'pre show'

1'Light' 4.160s Cue 2 'start’
1'Light' 6.200s Cue 3 'hit 1'
1'Light' 8.330s Cue 4 'hit 2'
‘Light' 10.430s Cue 5 'hit 3'
‘Light' 12.530s Cue 6 'hit 4'
‘Light' 14.600s Cue 7 'verse'
1'Light' 22.960s Cue 8 'chorus'
1'Light' 27.200s Cue 9 'frase’
1'Light' 31.300s Cue 10 'solo'

New TrackGroup

2 'Video' 0.001s Cue 1'pre show'
2'Video' 4.160s Cue 2'movie 1'
2'Video' 11.460s Cue 3 'movie 2'
2'Video' 18.760s Cue 4 'movie 3'
2'Video' 26.100s Cue 5 'movie 4'
2'Video' 31.300s Cue 6 'end'

] K EIl > )M e

<4 B3 Admin[Fixture]> iz

sheuts

E GieTh
Sync MAtricks M?s?er

= 100.0%
Single L
Step . ’
Aign Cursor Time Screen Y
< [ 0.00s Display 1

Readout Track Event TimeRange Marker Screen X
Percent TrackGroup 1 <No event> <No TimeRanges> <No Markers> Display 1




The application has several tools that will allow you to easily edit your cuelist.

1) Adding time.

You can correct or add e.g. 1 hour or several minutes to your timecode.

Export TimeCode for gma3

Track1 Track 2 )
Timecode number

Name Time Fade 1
pre show 00:00:00:00 2.09 Timecode label
start 00:00:04:05 2.09 TimeCode

o
€
3

hit 1 00:00:06:06 2.09 FPS

hit 2 00:00:08:10  2.09 30

hit 3 00:00:10:13 2.09 Add time

hit 4 00:00:12:16 2.09 01 00 00 00

verse 00:00:14:18 2.09 change time

chorus 00:00:22:29 2.09

frase 00:00:27:06 2.09 Page number

solo 00:00:31:09 2.09 !

Exec number
201

Sequence number
2

Sequence label
Light

© 0N OA N S

3

Page label
Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps
You are logged with Apple account

And the result:

Export TimeCode for gma3

Track1 Track 2
Timecode number

Name Time Fade 1
pre show 01:00:00:00 2.09 Timecode label
start 01:00:04:05 2.09 TimeCode

o
e
3

hit 1 01:00:06:06 | 2.09 EPS
hit 2 01:00:08:10 | 2.09 20

hit 3 01:00:10:13 2.09 .

hit 4 01:00:1216 | 2.09 = ool ol 6

© 0N O Ds N

3

verse 01:00:14:18 2.09 change time

chorus
frase
solo

You are logged with Apple account

01:00:22:29
01:00:27:06
01:00:31:09

2.09
2.09
2.09

Page number
1

Exec number
201

Sequence number
2

Sequence label
Light

Page label
Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help
Our Apps




can change the cue number using renumbering.

renumber cue

v all

start cue 1

from cue

start cue

new cue

cancel

Export TimeCode for gma3

Track1 Track 2 )
Timecode number

Iame Time Fade 1

}re show 00:00:00:00 2.09 Timecode label

start 00:00:04:05 2.09 TimeCode

Fit1 00:00:06:06 2.09 FPS

Fit2 00:00:08:10 2.09 30

kit 3 00:00:10:13 2.09 Add time

Vit4 00:00:12:16 2,09 00 00 00 00

verse 00:00:14:18 2.09 change time

¢horus 00:00:22:29 209

frase 00:00:27:06 2.09

<olo 00:00:31:09 209 J

Exec number
201

Sequence number
2

Sequence label
Light

Page number

Page label
Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps
You are logged with Apple account




renumber cue

Ell

start cue

¥ from cue

start cue

new cue 1"

cancel

Export TimeCode for gma3

Track1 Track 2 )
Timecode number

tame Time Fade 1

| re show 00:00:00:00 2.09 Timecode label

<tart 00:00:04:05 2.09 TimeCode

Kt 1 00:00:06:06 209 EPS

Jit2 00:00:08:10 209 20

Fit3 00:00:10:13 2.09 Add time

tit4 00:00:12:16 2.09 00 00 00 00

yerse 00:00:14:18 2.09 change time

¢horus 00:00:22:29 2.09 e —

frase 00:00:27:06 2.09

<olo 00:00:31:09 2.09 1

Exec number
201

Sequence number
2

Sequence label
Light

Page label

Page number

Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps

You are logged with Apple account

Question?
Contact us:

support@ofcourse.com.pl




